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INTRODUCTION 
 

The Model 3600i Single Lung PneuView System combines the unique features 

of the TTL Training/Test Lung with the data acquisition and processing capa- 
bilities of a personal computer.  This system was developed to allow the com- 
prehensive evaluation and demonstration of ventilation devices and principles. 
 

PneuView is a Windows based software program that serves as the link 

between the TTL and computer.  The interactive environment of multiple, 
overlapping windows, the combination of pull-down and pop-up menus,  
provides a user friendly system that will instill confidence and provide a useful 
lung simulation/data acquisition system. 
 
PneuView has many potential applications including: 

 • Ventilator Testing 

 • Product Demonstration 

 • Classroom Instruction 

 • Pulmonary Research 

 • Product Evaluation 

 • Design Engineering 

 • Quality Control 
  
 

ORGANIZATION OF THIS MANUAL 
 
This manual has been designed for use as a reference manual.  The beginning 
sections deal with general descriptions and information about the system. 
Subsequent sections address more specific operations and functions within  

the PneuView software.  Please refer to the Table of Contents for quick and 
easy reference to the various sections included in this manual. 
 
If you have any questions or need technical support, call Michigan Instruments 
at 1-800-530-9939. 
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1. Description 
 
General Information about the TTL 
 
The Model 3600i, Single Lung TTL provides an accurate simulation of the 
structures and mechanics of the adult human pulmonary system. An elastomer 
bellows with a residual capacity typical of an adult is used to simulate the lung. 
 
Gas is inserted into the lung through a simulated airway.  This insertion causes 
the vertical expansion of the lung, and a corresponding rise of the top plate. 
A tidal volume scale behind the top plate and a pressure gauge on the front 
of the unit can be used to verify measurements from a ventilation device. 
 
The lung compliance is accurately set and adjusted using a precision 
steel alloy spring.  Airway resistance is simulated using a “turret” with adjustable 
settings. These features allow the TTL to realistically simulate a wide variety of 
healthy or diseased lung conditions. 
 
Several special features add to the versatility of the TTL.  An oxygen sensor 
port on the back of the unit and auxiliary pressure ports adjacent to the pressure 
gauge provide sites for the tie-in of related monitoring equipment. 
 
The 3600i is completely portable and is mounted in a durable ABS plastic 
carrying case.  The top of the case is removed for use and should be replaced 
during transport.  Rubber feet on the bottom of the case provide 
stability and protection for the unit during use and transport. 
 
The 3600i houses an Electronic Interface Module, which facilitates the transfer 
of information from the TTL to a personal computer.  The module converts 
pressure signals from the lung and airway of the TTL into digital data.  The 
data is then processed by an appropriate personal computer using our 

customized PneuView Software.  The PneuView  program is specifically 
designed to acquire, interpret, and display data from the TTL.  Single breath 
information to long term trends can be dynamically displayed in real-time,  
and/or saved for future use.  Printed reports of all displayed information may 

also be easily generated.  The PneuView Software portion of this users 
guide provides complete installation and operating instructions. 
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The TTL—As Compared to Typical Patients 
 
The Model 3600i TTL is designed to realistically simulate the mechanics of the 
adult pulmonary system from the upper airway to the lung.  It is NOT a detailed  
model of actual human anatomy.  However, the TTL offers simulation capabili- 
ties and versatility not seen in other devices and is useful for a wide variety of 
applications.  The variable lung compliance and airway resistance allow for 
simulation of both healthy and diseased pulmonary conditions.  Table 1 
offers some typical values for healthy adults.  However, most ventilated 
patients do not possess these “normal” characteristics. 
 

  Compliance  .05 to .15 L/cmH2O 
  Resistance  0.5 to 5.0 cmH2O/L/sec 
  Respiratory Rate 10 to 20 Breaths per Minute 
  Tidal Volume  3 to 5  mL/kg of body weight 
  I:E Ratio  1:2 

     Table 1 
 
Pulmonary disease is often associated with a change in lung compliance and/or 
airway resistance.  Table 2  shows some of the changes that are typically seen in 
restrictive and obstructive lung disease. 
 
 Obstructive Disease Restrictive Disease 

Examples Asthma 
Emphysema 
Bronchitis 
COPD 
Airway Neoplasms 

Pneumonia 
Pulmonary Fibrosis 
Kyphoscoliosis 
Severe Obesity 
Lung Neoplasms 

Changes Increased Airway Resistance 
Increased Total Lung Volumes 
Decreased Expiratory Flowrates 

Decreased Lung Compliance 
Decreased Lung Volumes 
Increased Respiratory Rate 

     Table 2 
 
The TTL as Related to Ventilator Testing Standards 
 
To evaluate the performance of any mechanical ventilating device, a quantita- 
tive test lung which dynamically simulates human physiology should be utilized. 
Testing should take place on every ventilator before it is used in the clinical set- 
ting, and periodic testing is needed to ensure that the unit is performing in accor- 
dance with established standards and the manufacturer’s specifications.  
Standards published by the American National Standards Institute (ANSI), the 
International Organization of Standardization (ISO), and the American Society 
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for Testing and Materials (ASTM) outline minimum performance standards for 
mechanical ventilators.  These are the standards most frequently used by 
ventilator manufacturers.  The 3600i meets or exceeds the requirements set for 
testing in these standards.  
 
 Reference: Standard ANSI Z79.7 
   Standard ISO 5469:1987 
   Standard ASTM F 1100-90 
 
Specifications 
 
 Tidal Volume Capacity:  2.0 Liters 
 Residual Lung Volume:  1.022 Liters 
 Lung Compliance:     Adjustable: .01 to .10 L/cmH2O 

      Accuracy: ±3% (at calibration volumes) 
 Airway Resistance:   Adjustable:  5, 20, or 50 cmH2O/L/Sec 

      Accuracy:  ± 5% (at calibration flows) 
 Size:     25”x10”x13” 
 Weight:    25 Pounds (in case) 

Power Requirements: 12 VDC 500 mA (110 or 220 VAC           
adaptor supplied) 

 Data Link:    DB9f, pc serial cable 
 
Features and Components 
 
Frame 
The 3600i is built around an aluminum frame which provides stability for the 
components of the lung.  
 
The Lung (Bellows) 
The lung is simulated using an elastomer bellows, constrained by aluminum rings 
to ensure that filling of the “lung” results in a vertical rise of the top plate.  The 
bellows, at rest, retains a gas volume typical of an adult’s functional residual 
capacity for a single lung.  The bellows, secured to the top plate and frame of the 
3600i, is designed to withstand normal environmental conditions and inflation to 
at least 150 mmHg pressure. 
 
Compliance Setting 
The lung compliance is simulated using a precision steel alloy spring stretched 
between the top plate of the lung and the track on the side of the TTL frame. 
Lung compliance is adjusted by positioning the spring at calibrated points 
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along the top plate.  The greater the distance the spring is positioned from the 
hinge point of the top plate, the less compliant, or “stiffer” the lung. 
 
The Airway 
The airway consists of a “turret” which houses the resistors used to create 
varying levels of airway resistance. To change the resistance, turn the outside 
ring counterclockwise.  Rotate the knob at the bottom of the assembly to the 
desired resistance of Rp5, Rp20, and Rp50.  Tighten the outside ring by turning 
clockwise. Please see Figure 1 for display of the 3600i Turret Assembly.   

    
   Figure 1 – Model 3600i Turret Assembly 
 
The airway resistance exhibits parabolic characteristics, in regards to pressure 
change as a function of flow.  This nonlinear, parabolic characteristic is similar to 
that seen in standard endotracheal tubes.   
 
Scales 
Compliance Scale.  The compliance scale is used to set a particular com- 
pliance value for the lung.  This is done by positioning the compliance pointer of 
the compliance spring directly over one of the calibrated markings on the scale. 
 
Volume Scale.  The volume scale may be used to measure the volume within 
the lung.  While this scale is calibrated for various lung compliance’s, it is 
recommended to use the PneuView software because of the low resolution. 
 
Oxygen Analyzer Port 
Oxygen concentration can be monitored in the lung through the oxygen analyzer 
port located on the back of the unit.  The 15 mm fitting is designed to accept 
most common oxygen analyzers.  When not is use, the oxygen port is covered 
and sealed with the port cover. 
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Pressure Gauge 
The pressure gauge is located on the front of the 3600i.  The lung pressure and 
proximal pressure are measured with this gauge.  A toggle switch located to the 
left of the gauge controls which pressure is measured. 
 
Auxiliary Pressure Ports 
To the left of the gauge is an auxiliary pressure port for measuring airway 
pressure with other pressure sensing or measuring equipment.  To the right of 
the gauge is an auxiliary pressure port for measuring lung pressure with other 
pressure sensing or measuring equipment.  These ports are equipped with a  
check valve and remain closed until the port is mated with a miniature quick 
connector.  These connectors are supplied with the 3600i. 
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2. Setup and Operation 
 
Lung setup: 
1. Set the 3600i on a level surface. 
2. Remove the top cover of the carrying case by unlatching the four clasps 

on each side. 
3. Raise the volume plate scale by grasping the volume scale latch knobs on 

the bottom of the scale and pull them towards each other (see arrows on 
volume plate).  Lift to upright position and release knobs. 

 
The system is now ready for use without the computer interface. 
 
3600i Computer Interface Setup 
1. Connect one end of the DB9F serial cable (supplied with unit) into the 

personal computer.  Connect the other end into the serial port located on the 
left side of the 3600i. 

2. Attach the power jack into the 3600i (located to the left of the serial port 
connection) and plug the transformer into an appropriate AC power source. 

3. Turn the power switch (located on the front of the unit) to the “on” position. 
4. The PneuView Software program must be installed and operational on your 

personal computer.  See PneuView Software setup for complete instructions 
on software installation and operation. 

 
 
Single Lung Simulation 
1. The desired airway resistance is selected by using the “turret” assembly on 

the front of the unit.  Either Rp 5, Rp 20, or Rp 50 can be chosen. 
To adjust resistance: 

A. Turn outside ring on turret assembly counter-clockwise until loose. 
B. Move resistor selector to the desired resistance. 
C. Tighten outside ring by turning clockwise. 
D. Attach ventilator circuit to the airway. 
 

2. On the right side of the unit, select the desired compliance by first loosening 
the knob located above the compliance spring. 

3. Grasp the compliance spring and slide the entire mechanism until the pointer 
is positioned over the desired setting.  Lock in place by tightening the knob. 

 
NOTE:  For accuracy and consistency, the compliance spring must be 
perpendicular to the top plate during use. 
 
CAUTION:  Changing the compliance setting while ventilating the lung may 
cause damage to the unit. 
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The TTL may now be ventilated by attaching an appropriate connector from a  
ventilation device to the turret assembly of the 3600i. 
         
Measuring Oxygen Concentration in the Lung 
1. Unscrew the oxygen port cover on the back of the unit. 
2. Place an appropriate oxygen sensor (15 mm fitting) into the adaptor. 
3. Replace the cover when finished. 
 
Care of the 3600i after Ventilation with Humidified Gases 
The airway and lung of the 3600i are constructed of noncorrosive materials. 
Typical humidification agents such as sterile water or normal saline will not 
damage the instrument.  Any accumulated fluid can be drained out through the 
oxygen sensor port.  After any fluids are drained from the unit, the 3600i should 
then be ventilated with dry gas for several minutes.  For more information on the 
use of the TTL with specific chemical agents and medications, contact Michigan 
Instruments, Inc. 
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3. Software Operation 
 

          Addendum 

   PneuView Software Upgrade 
           Version 1.06 
 
Michigan Instruments continues to add to the capabilities of the PneuView 
System.  In response to requests from current and potential PneuView 
customers, our newest upgrade allows for the export of PneuView files for import 
of data into various software applications.  This feature is described below. 
 

Export Report Text File 
 
This function will allow the user to generate a formatted text file containing the 
PneuView Notes, Tabulated Data and Trend Test Results.  The text file is 
formatted to be both presentable as a readable document and easily assimilated 
into other databases such as Microsoft applications and other dedicated 
equipment management database systems. 
 
To export this data, go to File on the menu bar, then select Export Report Text 
File.  The Export Test Report to Text File dialog box appears.  Select the Pneu- 
View file to be exported and where the file should be exported to in the Save In 
box.  Click Save.   An information box will appear stating: The report text file: 
(destination directory and file name will be listed) has been saved.  The file will 
be saved with a .txt extension.   
 

Export Real Time Data 

 
This function allows for the translation of PneuView data files into delimited ASCII 
text files that should be readable by any text editor, spreadsheet program, or 
data analysis application. 
 
To export this data, go to File on the menu bar, then select Export Real Time 
Data.  The Save Real-Time Data in ASCII Format to… dialog box appears.  
Select the PneuView file to be exported and where the file should be exported to 
in the Save In box.  Click Save.  An information box will appear stating: The text 
data file (destination directory and file name will be listed) has been saved.  The 
file will be saved with a .txt extension.  
 
 
The application that the PneuView file is being translated for should have the 
capability to import the delimited format of the PneuView file.  All data is 
translated into rows and columns. 



3. Software Operation 
 
Limitation of Liability 

Michigan Instruments warrants that the PneuView software will conform to the 
published specifications and documentation, provided that it is used on a 
computer system for which it is designed.  Michigan Instruments also warrants 
that the supplied distribution disks and documentation are free from defects in 
materials and workmanship for 90 days after delivery.  Michigan Instruments will 
replace defective disks or documentation at no charge, provided you return the 
item to Michigan Instruments within 90 days of delivery. 
 
Except as provided above, Michigan Instruments makes no warranty or 
representation, either implied or expressed, with respect to this program or doc- 
umentation, including their quality, performance, merchantability, or fitness for a 
particular purpose. 
 
Because computer programs are inherently complex and may not be completely 
free of errors, you are advised to verify your work.  In no event will Michigan 
Instruments be liable for direct, indirect, special, incidental, or consequential 
damages arising out of the possibility of such damages.  In particular, Michigan 
Instruments is not responsible for any costs including, but not limited to those 

incurred as a result of lost profits or revenues, loss of use of the PneuView 
program or computer hardware, loss of data, claims by third parties or for other  
similar costs.  In no case, shall Michigan Instruments’ liability exceed the amount 
of the payment price. 
 
Copyright 
Under the copyright laws, neither the documentation nor the software may be 
copied, photocopied, reproduced, translated, or reduced to any electronic 
medium or machine-readable form, in part or in whole, without the prior written 
consent of Michigan Instruments, Inc. 
 

Copyright   1999  Michigan Instruments, Inc. 
    4717 Talon Ct. S.E. 
    Grand Rapids, MI  49512    USA 
 
Toll Free:  800-530-9939 TEL:  616-554-9696  FAX:  616-554-3067 
email:  mii@michiganinstruments.com    web site:  www.michiganinstruments.com 
 
Acrobat Reader Copyright 1987-1996 Adobe Systems Incorporated.  All rights reserved. 
Adobe and Acrobat are trademarks of Adobe Systems Incorporated which may be registered in 
certain jurisdictions. 
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General Information 
 
Program Requirements 
Your computer system must possess the following minimum specifications to 

guarantee proper operation of PneuView: 
 

•Pentium  with 100 MHZ Processor or better 

•10 MB Hard Disk Space  available 

•16 MB RAM 

•1 Free Serial Port 

•640 x 480 16 Color Display 

•Windows ’95, Windows ’98, or Windows NT Operating System 
 
CAUTION: Certain screen saver programs and/or power management 
utilities may interfere with the continuous acquisition of data through serial 
ports.  Therefore, it is important that such programs and utilities be 
disabled when running the PneuView system, particularly during trend 
testing. 
 
Technical Support 
To help ensure maximum performance and productivity from your equipment, 
PneuView comes with Michigan Instruments’ commitment to total customer 
satisfaction.  If you have a question, please call us at (616) 554-9696, or 1-800-
530-9939, or e-mail us at mii@michiganinstruments.com. 
 

  Technical Support – PneuView 
  Michigan Instruments, Inc. 
  4717 Talon Ct. SE 
  Grand Rapids, MI  49512 
  USA 
 
Please include the following information when you contact Michigan Instruments: 

•Product name, serial number, and Software Version number of the product. 

•Computer brand, model, and type of system used with the PneuView Software. 
 
Software Installation 
The enclosed disks provide all of the program files needed to operate 

PneuView as it interacts with the 3600i TTL. 
 
Installation instructions are provided at the beginning of this manual.  If you any 
questions about installation, please call Michigan Instruments. 
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Welcome to PneuView! 
 

To begin the program, click on the PneuView icon on the Windows desktop. 
The ”Welcome to PneuView!” title screen will appear.  The following buttons can 
be selected to operate the system: 
New Project:   Begins a new project and records data from the test lung in real-
time. 
Select Template:  Selects an existing template of specific reference conditions, 
notes, and display options. 
Open Project:  Opens an existing project of saved files. 
Working Directory:  Allows the user to open existing directories or create new 
ones.  This conforms to Windows file handling structure. 
 
Under Select Template, there is a check box titled Connect to Test Lung at Start 
up.  This box will normally be checked for proper communications with the test 
lung at start up. However, if the user would want to open existing projects, or 
create new templates without being connected to the test lung, this box should 
not be checked. 
 
At the bottom of the title screen are four more selections called Communications 
Test Lung, Start From Scratch, and Exit.  Communications sets the correct serial 
communications port for data coming in the computer.  Test Lung allows the user 
to set the correct test lung settings before acquiring data.  Start From Scratch 
allows the user to set up or customize a New Project screen.  Exit  will close the 
PneuView  program.  See figure 1 for PneuView Title Screen display.        

 
Figure 1 -- PneuView Title Screen    

 
 
New Project                       
Select New Project  from the PneuView Title Screen to begin acquiring data from 
the test lung.  The Calibration - Zero Transducers dialog box appears.   
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This box allows the user to calibrate the transducers before acquiring data.  See 
Figure 2 for the Calibration - Zero Transducer dialog box. 
 

 
 
  Figure 2 –  Calibration - Zero Transducer Dialog Box 
 
To ensure the greatest possible accuracies with this program, simply press the 
Zero buttons. (See instructions in the dialog box.)  
 
Once the transducers are set at zero, press the close button.  The New Project 
Screen will appear containing three windows: Measured Parameters, Graph, and 
Notes.  Data will appear in the Measured Parameters window and waveforms will 
appear in the Graph window.  Text can be typed into the Notes window.  Each 
window can be sized as desired; enlarged to full screen or minimized.  From the 
New Project window, other  features can be accessed such as Ventilator 
Performance Trending and Tabulated Data.  All information can be saved by 
using the standard Windows Save commands found in the File menu. (See 
Pages 18-19 for instructions on saving files.)  Please see Figure 3 on page 12 for 
display of New Project screen. 
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Figure 3 – New Project Screen 
 

The Acquire button (the green arrow on the tool bar) is used to start acquiring 
data.  To the right of the Acquire button is the Pause button.  When New Project 
is selected from the PneuView Title Screen, the Acquire button will default to the 
“on” position and begin acquiring data.  To pause the display, press the Pause 
button.  To resume the display, press the Pause button again.  See Figure 4 for a 
display of the Acquire button and Pause button. 
  

  Figure 4 – Acquire button and Pause button 
            
NOTE:  When Acquire is stopped, (button out) data is no longer being 
acquired.  When restarted, the display begins where it was stopped.  When 
in Pause, data continues to be acquired.   When restarted, the data display 
resumes as if it was never stopped. 
 
Display Windows. 
A. Measured Parameters.  This window is a display of  respiratory parameters 
as calculated by PneuView.  The user has a choice of 24 different parameters  
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that can be selected from a pop-up menu.  To access the pop-up menu, move 
the cursor into the Measured Parameter window and right click the mouse. 
Choose Set Up from the menu in the dialog box.  This will open the Select 
Parameters Window, allowing the user to check the desired parameters.  See 
figure 5 for the Select Parameters window. 

 
 Figure 5 – Select Parameters Window 
 

Other commands on the menu are Print Preview, Print, and Print Setup.  The 
Print commands allow the user to organize files for printing.  (See page 32 for 
instructions on printing files). 
            
On the tool bar is a Measured Parameter button.  This button will create a new 
parameters window if one was not created during set up.  See figure 6 for a 
display of the Measured Parameter button. 
 

 
   Figure 6 – Measured Parameter Button 
 
NOTE:  The Select Parameters window can also be accessed by selecting 
the Measured Parameter button, then going to Window on the Menu bar, 
and selecting Set Up. 
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B. Notes. The Notes window is a text editor and provides capabilities for 
entering, editing, and saving text.  A menu can be accessed by right clicking the 
mouse in the notes window.  The menu commands are File, Edit, Justification, 
Font, and Word Wrap.  Standard sub-menus appear when selecting these 
commands.  
 
The tool bar contains a Notes button.  This button is used to create a new notes 
window if one was not created during set up, or to open an existing notes file.  
See figure 7 for a display of the Notes button. 

 
Figure 7 – Notes Button 

 
NOTE:  The Notes menu can also be accessed by selecting the Notes 
button, then going to Window on the Menu bar, and selecting Set Up. 
 
C. Graph. The Graph window is capable of displaying real time graphs               
(waveforms) of up to three calculated parameters simultaneously.  These 
waveforms are displayed in easy to distinguish colors.  The color of a particular 
waveform will match the color of its corresponding Y-axis at the left of the plot 
window.  The zero axis for each waveform within the plot window will also be 
indicated by a color coordinated dotted line matching the color of the 
corresponding waveform.   
 
Right clicking the mouse in the graph area will display a dialog box .  Choose Set 
Up to access the Graph Set Up Dialog window. This window allows the user to 
set up graphs for display along with a time scale and choice of color of the   
waveform.  See figure 8 for a display of the Graph Set up dialog window. 
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              Figure 8 – Graph Set Up Dialog window 

 
The Graph button on the tool bar is used to create a new graph window if one 
was not created during set up.  See figure 9 for a display of the Graph button. 

        
  Figure 9 – Graph Button   

 
NOTE:  The Graph Set Up Dialog window can also be accessed by selecting 
the Graph button, then going to Window on the Menu bar and selecting Set 
Up. 
 

Test Lung Settings 
The Test Lung settings are displayed on the status bar at the bottom of the New 
Project screen.  To access these settings, double click the mouse on the status 
bar.  These settings (which can be adjusted by the user using a pull-down menu) 
include Lung Compliance, Airway Resistance, Gas Temperature, Barometric 
Pressure, Gas Reference Conditions, and Communications Port.  The Serial 
Number of the Test Lung is also displayed here.  Verify that the serial number of 
the test lung and the software are the same. 
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The Test Lung Settings can also be selected from the PneuView Title Screen 
under Test Lung.  
 
NOTE:  In order for PneuView to maintain accuracy, it is extremely 
important that the settings on the test lung (compliance and resistance) 
match the settings in the PneuView Program.  The Gas Reference 
conditions, Barometric Pressure, and Gas Temperature should also be set 
as accurately as possible. 
 
See Figure 10 for a display of the Test Lung Settings Window. 
 

 
Figure 10 – Test Lung Settings window 
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Changing the Test Lung Settings 
Test Lung S/N -- This should match the serial number on the PneuView software 
disk. If the serial numbers do not match, check both the test lung and software 
disk serial numbers.  Call Michigan Instruments if you need a new disk(s). 
 
Airway Resistance – This is adjusted by the pull-down menu to the right of the Rp 
value.  The choice of  Rp5, Rp20, and Rp50 is selected by the user. 
 

NOTE:  The airway resistance on the test lung must match the resistance 
value in the Test Lung Settings window. 
 
Lung Compliance --  This is adjusted by the pull-down menu to the right of the 
Compliance number.  The range is adjustable from .01 to .10 L/cmH20. 
 
Note:  The Lung compliance on the test lung must match the compliance 
setting in the Test Lung Settings window. 
 
Gas Reference Conditions – Again, this is adjusted by the pull-down menu.   
The following choices are available: 
 
ATPX – Ambient Temperature (current gas temperature), barometric Pressure 
(current barometric pressure) and (X) relative humidity.  Data collected from the 
TTL is collected at ambient (ATPX) conditions.  When ATPX is selected as the 
reference unit, the volumes and flowrates calculated and displayed will represent 
those that occurred at the TTL under the current ambient conditions.  This is the 
default setting of the PneuView software. 
 
ATPD – Ambient Temperature (current gas temperature), barometric Pressure 
(current barometric pressure) under Dry conditions (0% humidity).  
 
ATPS – Ambient Temperature (current gas temperature) and barometric 
pressure (current barometric pressure) under Saturated conditions (100% 
humidity). 
 
Since relative humidity has virtually no effect on the calculations within the 
operating range of the TTL, selection of ATPS will produce the same results as 
selection of ATPX. 
 

BTPS – Body Temperature (98.6°F, 37°C) and Barometric Pressure (760 mmHg. 
101.3 kPa) under Saturated conditions (100% Humidity). 
 
Selection of BTPS will cause PneuView to display volume and flowrate 

information after it has been converted to body conditions (98.6°F, 760 mmHg) 
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The information supplied by PneuView will represent that which would have 
occurred had the gas temperature and barometric pressure been at body 
conditions. 
 

NTPD – Normal Temperature (68°F, 20°C) and barometric Pressure (760 mmHg, 
101.3 kPa) under Dry conditions (0% humidity). 
 
When NTPD is selected, the calculated and displayed volumes and flowrates will 
be converted to normal conditions.  This requires that the Gas Temperature and 
Barometric Pressure reference values be entered as accurately as possible for 
the conversion calculations to be made correctly.  The volumes and flowrates 
displayed will be those that would have occurred had the gas temperature been 

at normal conditions (68°F, 760 mmHg). 
 

STPD – Standard Temperature (32°F, 0°C) and barometric Pressure (760 
mmHg, 101.3 kPa) under Dry conditions. (0% humidity). 
 
When STPD is selected, the volumes and flowrates calculated and displayed will 
be those that would have occurred had the gas temperature and barometric 

pressure been at standard conditions (32°F, 760 mmHg).  This requires that the 
values entered as the Gas Temperature and Barometric Pressure must be 
entered to represent the ambient conditions as accurately as possible.  This will 
ensure proper calculations and conversions for the displayed volume and 
flowrate information. 
 
The Importance of Test Conditions 
The test conditions MUST be entered and adjusted before acquiring and saving 
data.  These conditions not only serve as a reference when reviewing data, but 
are necessary for the proper calculation of volume and flow parameters. When 
data is saved, the test conditions are saved as a permanent part of the file. 
 
Retrieving a template will not change the test conditions, as the original 
conditions are necessary to generate accurate calculations and waveforms. 
 

Saving Data 
The principle function of the New Project screen is collecting and saving data 
from the TTL.  Digital pressure signals are taken from the TTL every 10 
milliseconds.  This raw pressure data is analyzed to determine fundamental 
information such as the beginning and end of breaths, and peak and baseline 
pressure points.  Saving the data allows the user to review and reproduce the 
displayed breath parameters and graphs as it was originally acquired. 
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PneuView provides three methods of saving up to 30 minutes of this raw 
pressure data.   The Save Data Buffer under the Data menu, the Save Project 
commands in the File menu and toolbar, and the Begin and End buttons on the 
toolbar provide methods of saving the raw pressure data. 
 
The Data Buffer 
The Data Buffer is a memory buffer, established by PneuView containing the last 
30 minutes of data collected from the TTL.   This data represents the pressures 
collected from the test lung and upper airway.  Pressure data is collected every 
10 milliseconds and 30 minutes worth of the most recent digital pressure data is 
retained in the buffer. 
 
The Data Buffer is initialized every time a New Project is selected, a reference 
condition has been changed, or after data has been saved.  
 
To save data from the data buffer, select Data from the menu, and press Save 
Data Buffer.  A dialog will appear prompting the user to name the file. 
 
Begin/End Save 
The Begin Save and End Save buttons are located at the top of the New Project 
screen.  When the Begin Save button is selected, PneuView begins and 
continues saving incoming data until the End Save button is selected. When the 
End Save button is selected, the user is given the opportunity to save the data 
segment under a default name or user entered name.  If  End Save is selected 
after more than 30 minutes of data has been saved, only the last 30 minutes will 
be saved to a file. 
 
The data files saved through the Begin/End Save commands can be opened for 
review through the Open Project menu item under File in the New Project screen, 
or through Open Project on the PneuView Title Screen. 
 
Other Save Commands 
Files can be saved with the Save Project button on the toolbar of the New Project 
Screen.  As soon as the New Project screen is selected, data is being acquired 
from the TTL.  When the Save Project button is selected, the Save all Current 
Project Files window will open and prompt the user for a file name. 
See Figure 11 for Save Project button. 

 
    Figure 11 – Save Project Button 
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Files can also be saved with the Save Project and Save Project as commands 
found in the File menu of the New Project screen.  The Save Project command 
has the same function as the Save Project icon.   Save Project as will allow the 
user to save files to different extensions, save the project for use in another 
program, or save a copy of a project to another file. 
 

Trend Testing 
Trend Testing is valuable in analyzing and documenting the performance 
characteristics of mechanical ventilation and related equipment over a long 
period of time.  With PneuView, trending is available for up to 72 hours.  

To access the trending environment in PneuView, select the Trend option from 
the menu bar.  A dialog box appears with Setup, Begin, and End. 
 
Setup (From Trend Menu) 
This initiates the trend test dialog, allowing the user to select conditions and 
parameters for a trend test.  A dialog box called Set up Trend Test appears.  The 
user will set up the Test Name, Test Length, Sample Interval (in minutes), and +/- 
Tolerance (in percent).  Pull down menus allow the user to choose the graphed 
parameters. 
 
The user has a choice of up to four different graphs under Initially Graphed 
Parameters.  These can be changed with pull down menus.  Also in the set up is 
a list of Measured Parameters.  The Parameters are listed along with the 
Measured value and Target value.  PneuView generates the measured value; the 
user enters the Target value.  After all of the values are selected, choose the OK 
button at the bottom of the Set up screen.  See Figure 12 for display of the Set 
up Trend Test dialog box. 

 
        Figure 12 – Set up Trend Test Dialog Box. 
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Begin (From Trend Menu) 
After the set up is completed, The Trend Graph screen is displayed.  The user is 
now ready to begin trending. Choose the Trend command from the menu bar. 
The commands Set up, Begin, and End appear.   Choose Begin to start trending.  
See Figure 13 for display of the Trend Graph Screen. 
 
NOTE:  The test lung settings should be entered and adjusted before 
acquiring and saving data in the Trend mode. 

 
     Figure 13  -- Trend Graph Screen. 
End (From Trend Menu) 
This causes a trend test in progress to be terminated before its set duration is 
complete.  The user is prompted to save or abort the test.  End is disabled if a 
trend test is not in progress. 

 

Once the test is completed, a dialog box prompts the user to save the data (as 
default or user selected file name.)  Name the project, choose Save, 
and the file will be stored with a .trd extension.  This file can be printed, or 
reviewed later. 
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Tabulated Data 
There is a provision to save individual sets of calculated measured parameters 
as raw data.  In PneuView, saving data in this manner is called “Tabulating.” 
 
Choose the Tabulate function to take a “snap shot” of the current respiratory 
parameter values in the Measured Parameters display window.  Each time the 
Tabulate key is pressed, another snap shot is taken and appended to the last 
snap shot creating a table of respiratory parameters in memory.  
 
NOTE:  Once the table is saved, no more tabulations can be added to that 
file. 
 
To Tabulate Data: 

1. From the New Project screen, choose the Select Parameters window by 
clicking on the “T” button on the Tool Bar.  See Figure 14 for display of the 
Tabulate button.  See Figure 15 for display of Select Parameters window. 

 
   Figure 14 – Tabulate Button 
 

 
   Figure 15 – Select Parameters Window 
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2.  Check the parameters to be measured with the left mouse button. The      
parameters can also be selected by pressing the space bar on the keyboard. To 
clear all of the parameters select the Clear All button.  To select all of the 
parameters choose the Select All button.  When OK is selected, a Data Table 
window appears.  See Figure 16 for display of the Data Table window. 

 
Figure 16 – Data Table Window 

 
3.  There are three ways to collect tabulated samples: 

A. Click the tabulate table button on the Data Table tool bar with the mouse.  
See Figure 17 for a display of the Tabulate Table button. 

 
Figure 17 – Tabulate Table Button 

 
B. Press F5 on the keyboard, or 
C. Right-click the mouse button in the top portion of the Data Table dialog 

box and select Tabulate.  Other functions by the right click include Open, 
Save, Save as, Clear, and Set up. 
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There are four other buttons on the tool bar with specific functions.  The clear 
button will clear the data table.  See figure 18 for the Clear button. 

        
    Figure 18 – Clear Button 

 
Select Parameters button gives the user the option of changing the measured 
parameters after a tabulation.  See figure 19 for the select parameters button. 
 

    
     Figure 19 – Select Parameters Button 
 
The Open Project  button allows other files to be viewed while tabulating data.  
See figure 20 for Open Project button. 
 

   
Figure 20 – Open Project Button 

 
The last button on the tool bar is the Save Project button.  This will save all 
tabulated files .  See figure 11 on page 19 for the Save Project button. 
 
NOTE:  Test lung settings should be entered and adjusted before acquiring 
and saving tabulated data. 
 
When a sample is collected, the values will be listed as Sample 1.  For each 
sample collected thereafter, the data will be listed as Sample 2, Sample 3, etc. 
 

NOTE:  No more than 20 samples can be collected in a single table. 
 

Type any notes for the appropriate sample in the Notes editor below the 
parameters.   
 
NOTE:  By right clicking the mouse in the notes table, a window appears 
with the commands Insert, Edit, Alignment, Font, and Word Wrap.  
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The file is saved by right clicking the mouse and selecting SAVE or SAVE AS, or 
by choosing the SAVE PROJECT icon on the tool bar of the Data Table window.  
These files are saved as Tabulated Measurement Files (.tab). 
 

Measure  
Choose the Measure function to display continuous flow and high pressure 
measurement values from the ventilation device.  This command is located under 
the Data menu on the New Project screen.  The following measurements can be 
acquired: 
 
Proximal Pressure (cmH2O) 

Lung Pressure (cmH20) 

External Pressure (psig) 
Flow Rate (L/min) 
 
CAUTION:  The oxygen sensor port located on the back of the test lung 
MUST be left open to prevent overinflation of the lung bellows while 
measuring flow. 
 
Resistance can also be selected. Choose Rp 5, Rp 20, or Rp 50 for the 
appropriate flow rate, listed as follows: 

Rp 5    140-240  L/min 

Rp 20    60-139    L/min 

Rp 50    14-59      L/min 

 

See Figure 21 on page 26 for Direct Measure Display. 
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Figure 21  – Direct Measurement Window 

 

Direct Measurements can be inserted into the Notes window by using the Cut, 
Copy, and Paste functions.  Access this feature by right-clicking the mouse in 
the Direct Measurement window. 

 

Reviewing Files 
Reviewing files allows for the critical examination of saved data files.  When 
data is selected for review, a static display of the entire data set is displayed in 
the graph window.  Special features in this mode allow the user to select 
specific segments of the data set for closer analysis. 

 

Files can be opened from the Open Project area in the PneuView Title Screen 
or from Open Project… in the file menu in the New Project screen.  Once this 
command is selected, the Open PneuView file(s) window is opened.  These 
files can be opened to review data files, trend data, and tabulated data.  See 
figure 22 on Page 27 for display of Open PneuView file(s) window. 
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   Figure 22 – Open PneuView file(s) window 

 

This window presents a file list and the drive and directory where these files are 
located.  All the files within the named directory are displayed alphanumer- 
Ically. 
 
Reviewing a Data File 
When a data file is opened for review, the file name is located at the top left of 
the screen. A graph will be displayed along with a scroll bar at the bottom of the 
screen. Any text that was entered at the time of the test will appear in the Notes 
window. See figure 23 on page 28 for a display of a reviewed file. 
 
 
 
 
 
 
 
 
   
        
           27 
 



 

 
Figure 23 – Review File Display 

 
The horizontal scroll bar at the bottom of the screen controls the time scale of the 
data recorded.  By holding down the left mouse button with the cursor on the 
scroll bar, the user can drag the arrow to a specific time of that test.  The 
waveform updates with the time scale.  The arrows on the keyboard will also 
adjust the time scale. 
 
The measured parameters can be updated by moving the cursor into the graph 
display and left click the mouse at various times of the test. 
 
Changing the Graph Window 
The graph window can be changed to display other waveforms such as baseline 
pressure or lung pressure.  To change the Graph window, move the cursor into 
the graph and right click the mouse.  This will open a window with the commands 
Zoom in, Zoom out, Set up, Preview, Print, and Print Setup.  Choose Set up  to 
open the Graph Setup dialog box.  See figure 24 for the Graph Set up dialog box. 
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     Figure 24 – Graph Setup Dialog Box 
 
Up to three graphs can be displayed in this program.  In Figure 23,  Proximal 
Pressure, Volume, and Flow are the chosen graphs.  To change the graph, click 
the down arrow to display the choice of graphs.  When a different graph is 
chosen, click OK and the graph window will automatically change. 
 
A multitude of colors are available for the user to choose by accessing the Color 
button.  If only one or two graphs are necessary to view, uncheck the Visible box. 
The Minimum and Maximum scale are adjusted to correspond to the 
measurement being displayed.  The Time Scale will adjust the graph display from 
10 seconds up to 30 minutes. 
 
When all of the changes are complete in the Graph Setup Dialog box, choose OK 
to return to the review file display. 
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Zoom in  and Zoom Out controls are accessed by choosing the buttons at the top 
of the screen.  See figure 25 for a display of the Zoom buttons.  
 
 

 
   Figure 25 – Zoom In/Zoom Out Buttons 
 
Zoom in will give the user a closer look of the data in a graph window.  Zoom out 
will change the graph to allow more data to appear in the window. 
 
NOTE:  The Zoom  controls can also be accessed by moving the cursor 
into the graph window, right clicking the mouse, and choosing either Zoom 
in or Zoom out. 
 
 

Reviewing Trend Test Files 
To review a trend file, go to the Trend command on the menu bar and select 
Review.  A window will open displaying all of the trend files.  Choose the file that 
is to be reviewed.  The Trend Test Results window will open and display the 
results of the test.   See figure 26 for display of the Trend Test Results window. 

 
  Figure 26 – Trend Test Results Window 
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The Trend Test Results window  list the test name, test length, sample interval, 
total samples, and test date along with the reference conditions. 

 
The Low, Target, and High values correspond to the values that were entered in 
the Trend Set up.  The Minimum, Average, and Maximum are the actual values 
of the parameters recorded during the test.  The Minimum time is the time of the 
minimum value, and the Maximum time is the time of the maximum value. 
 
Review Graphs allow the user to view the entire graph (or graphs) of the trend 
test.  Choose the graph(s) from the pull-down menu and select Create Graph.  
The graph will appear on top of the Test Results.  A horizontal scroll bar at the 
top left of the graph allows the user to view the entire test.  This is accessed by 
left clicking the mouse on the scale, and sliding the arrow in either direction.  A 
time scale is located at the bottom of the graph that will correspond with the scroll 
bar.  There is also a pull-down time scale menu located to the right of the scroll 
bar.  This will change the time scale on the graph without using the scroll bar. 
Also, the color of the graphs and background can be adjusted by the user by 
using the Avg. Color, Back Color, Min  Color, and Max Color.  See figure 27 for a 
display of the Trend Graph. 

 
   Figure 27 – Trend Graph Display 
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Reviewing Tabulated Files 
To review tabulated files, choose Review Data Table under the Data command 
on the menu bar.  The Open Data Table window will open and display the saved 
tabulated data files.  After selecting the file for review, the Data Table  window 
appears with the actual tabulated data.  See figure 28 for a display of the 
reviewed Data Table. 
 

     
Figure 28 – Data Table Display 

            
This table displays all of the respiratory parameters along with the reference 
conditions.  In the right hand corner of the table is a Hide button.  This will move 
the display into the background so the user can view other functions of the 
programs.  To recall the table, select the Tabulate button on the tool bar. 
 

Printing Files 
To print, choose Print from the file menu. This will allow the user to print a  
number of reports listed below.  Also, the preview command allows the user to 
view the report before printing. 
  
Basic Report – This will print the Measured Parameters, Notes, Graphs, and 
Reference Conditions from the New Project Screen. 
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Trend Report – This will print the results of a trend test including the graphs,  
measured parameters, and reference conditions. 
 
Data Table Report – This will print the tabulated data and notes from a data 
table.  
 

Notes – Notes are saved with a New Project or a Trend Test and can be printed 
seperately from these files. 
 
See Figure 29 for a display of the print commands. 

 
                            Figure 29 – Print Commands From File Menu. 
 
 
            

Creating and Saving Templates 
 

A template is a set of specific Measured Parameters, Graphs, Reference 
Conditions, and Notes inputed by the user to create a test for a specific ventilator 
or other application. 
 
With PneuView, templates can be created in the New Project screen, or the Data 
Table. 
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To create a Template, go to New Project from the PneuView Title Screen.  Select 
the desired measured parameters, graphs, and reference conditions.  Type in 
any notes in the notes window. 
 
After all the changes have been made, go to the Options command on the menu 
bar and select Save Template.  The Save Template File dialog box will appear 
prompting the user to name the template file.  Type in the file name, and select 
the Save button.  Templates are saved with a .pvt extension.  See Figure 30 for 
the Save Template File Dialog Box. 

 
.   Figure 30 – Save Template File Dialog Box 
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4. Applications 
 
The 3600i offers a unique combination of versatile lung simulation and compre- 
hensive information gathering and display, including a multitude of respiratory 
parameters and waveforms.  This makes the 3600i the perfect tool for an end- 
less number of applications including: 

 •  Performance testing of ventilators and related equipment. 

 •  Classroom instruction on mechanical ventilation equipment, techniques, 
     and phenomena. 

 •  Product demonstration and evaluations. 

 •  Product development and quality control. 

 •  Pulmonary research. 
 
To offer examples of all the applications for this system would be impossible, as  
new ones are continually being discovered or developed by users of the system. 
The following are examples of some of the common applications for which the 
Single Lung PneuView System can be applied. 
 
Ventilator Testing 
The Joint Commission on Accreditation of Healthcare Organizations (JCAHO) 
states, “All equipment shall be calibrated and operated according to the manu- 
facturer’s specifications, and shall be periodically inspected and maintained 
according to an established schedule as part of the hospital’s preventive 
maintenance program.” 
 
The 3600i is designed to allow performance testing of mechanical ventilators 
within their range of typical use.  Protocols for testing may be stored in Pneu- 
View software, allowing routine testing to be performed quickly and consistently. 
 
Adult Ventilator Testing Application 
Example A.  The following is a routine test protocol to create a table for  
documentation of test results. 
 
Test Protocol: 
 
    Test 1  Test 2  Test 3  Test 4  Test 5 

Rate (bpm)      10     20     20     20     30 
Vt (mL)      1000    800     750     500     500 
Flow (Lpm)      80     60     60     60        40 
PEEP (cmH20)   0     60     60     60     40 
Compliance      .05     .05     .02     .02     .01 
(L/cmH20) 
Resistance      5     20     20     20     50 
(cmH20/L/sec) 
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Procedure: 
1.  Adjust the compliance and resistance on the 3600i as called for in Test 1 

 of the above protocol. 
2.  Attach the patient connection of the ventilator’s breathing circuit to the 

 airway of the 3600i. 
3.  Set the ventilator as described in Test 1 of the above protocol. 
4.  With the PneuView software running on your computer, enter the above  

 protocol in the Notes window. 
5.  Select the respiratory parameters from the Parameters window in PneuView 

 to be displayed and recorded in the table. 
6.  Select any waveforms to be displayed while testing. 
7.  Verify that the compliance and resistance values entered in the Reference 

 Conditions window corresponds with the 3600i setting. 
8.  When respiratory values appear on the screen, save them with the Tabulate 

 function. (This will be Test 1.) 
9.  Run Tests 2 through 5 of the protocol, adjusting the 3600i, ventilator, and  

 reference conditions between each test.  Use the Tabulate function for each 
 set of parameter values. 

10.  Save this format as a template for future testing. 
11.  Save the tabulated file and print a report of the table and notes comparing  

 the ventilator settings to the measured values.  
 
 
Example B.  24 hour trend test to evaluate an unexplained change in tidal volume 
after two hours of ventilator use.  NOTE:  A trend test can be set up to run for up 
to 72 hours. 
 
Procedure: 
1. Adjust the compliance and resistance on the 3600i to roughly simulate the 

patient on which the ventilator had been operating. 
2. Attach the breathing circuit of the ventilator in question to the airway of the 

3600i, and set the ventilator to operate as is was on the patient. 
3. With PneuView running, enter the Ventilator Performance Trending mode. 
4. Enter the correct reference conditions in the PneuView software. 
5. Select the Parameter Data Trends (including tidal volume) to be displayed. 
6. In the Notes window, enter a description of the problem you are assessing. 
7. Enter the test setup:  Length of Test—24 hours; Interval Time—15 minutes. 
8. Enter Begin Test and let the ventilator run 24 hours, without interruption. 
9. View the trended data, add notes, save the results, or print a report. 
 
 
Classroom Instruction/Demonstration 
The 3600i Single Lung PneuView System is a dynamic lung model which can be 
of great assistance in the classroom.  The adjustable lung compliance and  
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resistance allows the instructor or student to demonstrate or investigate a wide 
variety of ventilation phenomena.  The relationships between pressure, volume, 
and flow are more easily understood when dynamically displayed with the TTL, 
and the PneuView software provides yet another mechanism to demonstrate 
and evaluate the patient (TTL). 
 
Example D.  The distribution of delivered tidal volume with worsening unilateral 
lung disease (e.g. pneumonia). 
 
Procedure: 
1. Set the lung compliance of the TTL to .05 L/cmH20. 
2. Select an Rp5 resistor in the airway turret assembly. 
3. With the PneuView running, enter the correct compliance and resistance 

values in the Reference Conditions Window. 
4. Display Tidal Volume in the Respiratory Parameters window and Waveform 

Display window. 
5. Enter a description of the demonstration in the Notes window. 
6. Using a ventilator or resuscitation bag, ventilate the TTL at a rate of 12  

breaths per minute and tidal volume of approximately .800 liters. 
7. Note the tidal volume measured. 
8. Change the compliance of the lung to .03, then .02, and finally .01, and note 

the lung volumes with each change. 
9. Save this demonstration as a template for future demonstrations. 
 
Example D.  AutoPEEP caused by increased upper airway resistance (e.g. use 
of small endotracheal tube). 
 
Procedure: 
1. Set the airway resistance on the turret for Rp20. 
2. Set the lung compliance at .08 L/cmH2O. 
3. With PneuView running, enter the correct conditions in the Reference  

Conditions window. 
4. Display proximal airway pressure and lung pressure in the Waveform Display 

window. 
5. Enter a description of the demonstration in the Notes window. 
6. Ventilate the TTL at a rate of 26 BPM and a tidal volume of 1.0 Liters, with a 

baseline (PEEP) of zero. 
7. Note the inadvertent PEEP in both proximal airway and lung pressures  

caused by the increased airway resistance.  Also, note the difference in the 
baseline pressure of the proximal airway and lung. 

8. Save this as a template for future demonstrations. 
 
Other Common Applications 

••••  Performing in-hospital ventilator training sessions. 
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•  Checking ventilator systems for leaks. 

•  Documentation of preventive maintenance checks of ventilators. 

•  Demonstrating the difference in cycling and limiting mechanisms in mechanical 
    ventilators. 

•  Evaluating new mechanical ventilators and ventilation monitoring equipment. 

•  Identifying optimal ventilator settings for particular patients and conditions. 

•  Performing work of breathing studies. 

•  Evaluating resuscitation bag techniques of paramedics, respiratory care 
    practitioners, and students. 

•  AND MANY MORE. 
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5. Maintenance and Service 
 
The 3600i Single Lung PneuView System is designed to provide years of  
trouble-free service.  Every unit is calibrated and thoroughly checked before 
leaving the factory.  All parts and accessories of the unit are designed for 
consistent, repeatable, long-term performance. 
 
Other than replacement of accessories, the 3600i is NOT intended to be ser- 
viced by the customer.  If problems develop which cannot be easily corrected 
by using this manual, please contact Michigan Instruments’ Service Department 
at 1-800-530-9939.  Michigan Instruments also recommends that the unit be 
returned to the factory every 2 years for complete recalibration and any 
necessary repairs. 
 
Calibration Check 
The accuracy of all measurements and calculations made by PneuView is 
dependent upon the proper mechanical and electrical calibration of the system. 
This calibration can be checked using the following equipment and procedures: 
 
Equipment Needed: 
•  PneuView 3600i Software (Test Lung operating with PneuView Software) 
•  Calibrated 1-liter syringe (or other calibrated volume injector) 
•  Independent, reliable pressure gauge or manometer (+/- 1% or .1 cmH20) 
 
The following procedure can be used to quickly check the calibration of your 
3600i system.  It is not a calibration procedure and does not guarantee the 
accuracy of the system, but it will indicate if a more thorough recalibration is 
necessary. 
 
Procedure 
1. Enter the Calibration mode of PneuView.  Displayed pressures for the airway 

and lung should read zero (0.0). 
2. Set the lung compliance at .10 L/cmH20. 
3. Draw 1.0 liter of air into the insertion syringe, then connect it to the airway of 

the test lung. 
4. Insert the 1.0 liter of air into the adult test lung using a smooth steady motion. 
 
NOTE:  It is very important that the syringe is empty after injecting air into the 
   test lung.  If the syringe is not completely emptied, the remaining air 
   in the syringe will affect the volume and pressure readings in the lung. 
 
5. Wait 2 seconds after the insertion to allow pressure to stabilize in the sys- 

tem, then record the pressure generated in the lung.  Verify that it falls within 
the acceptable tolerance as shown in Table 1, below. 
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6. Repeat these insertions into the lung using the compliance settings shown 
in Table 1 and verify the pressure generated in the lung falls within accept- 
able limits. 
 

 
       Compliance Setting           Pressure Limits                                                 
                      .10                            9.7 to 10.3 
                      .05                          19.4 to 20.6 
                      .01                          97.0 to 103.0 

    Table 1—Calibration Values   
 

If the displayed pressures do not fall within the acceptable range for any 
given compliance setting, repeat the insertion to verify that there has been no 
error in the technique.  If the values are still not within the specified ranges, a  
mechanical adjustment and recalibration of the test lung may be required. 
Contact Michigan Instruments for details. 

 
Model 3600i Leak Test 
If you suspect an air leak in the test lung, use the following procedure to 
locate the source of the leak. 

1. Set the compliance spring on the lung at .02. 
2. Enter the Calibration mode of the PneuView program. 
3. Inject 1.0 liter of air into the lung through the airway and read the lung 

pressure. 
4. Hold the volume in the lung for 30 seconds, and again read the lung 

pressure.  The pressure should not drop more than 1.0 cmH2O in  
30 seconds. 

 
If an unacceptable leak exists in your system, and you are unable to locate the 
source, please contact Michigan Instruments’ Service Department. 
 
Warranty Agreement 
Your Model 3600i Single Lung PneuView System is warranted by Michigan 
Instruments, Inc. Grand Rapids, Michigan, to be free of defects in material and 
workmanship for a period of two (2) years from the date of its receipt by the end 
purchaser, excluding the diaphragm gauge contained therein. 
 
All repairs necessitated by malfunction of this equipment during the warranty 
period, when in normal use in accordance with instructions provided, will be 
accomplished at the Michigan Instruments, Inc. factory, without charge other 
than the cost of transportation to the factory.  Michigan Instruments, Inc. under- 
takes NO LIABILITY HEREUNDER FOR SPECIAL OR CONSEQUENTIAL 
 
           40 



DAMAGES, or any other expense or liability beyond the furnishing of materials 
and labor for the repairs covered hereby.  The warranty does not cover mars and 
blemishes, scratches or denting which may result from normal use of this equip- 
ment, or malfunctions due to mishandling or damaging accidents. 
This warranty is VOID unless the equipment to be repaired is returned in the 
original protective factory carton.  If unavailable, the protective carton may be 
obtained from Michigan Instruments, Inc. 
 
If the attached warranty registration card is not returned, the warranty period 
will begin the date the instrument was shipped from the factory. 
 
This warranty is in lieu of all other warranties express or implied, and shall be 
void as to any products which have been repaired or altered by others, or have 
been subject to misuse or abuse.  The buyer agrees that this written warranty  
constitutes the entire agreement as to warranties between the parties.  Any 
prior or contemporaneous oral statements which have not been written into this 
agreement are not binding and this contract shall not be rescinded or modified 
except by a signed agreement. 
 
Factory Service Policy 

The Model 3600i Single Lung PneuView System is covered by a limited, two 
year warranty.  Return the postage paid registration card promptly to ensure 
proper registration of your unit and help expedite repairs if they should ever  
be necessary. 
 
The Model 3600i is manufactured to very demanding quality standards. It is 
designed to provide years of trouble free service if proper care is taken in its 
operation.  This instrument should be used and maintained as outlined in this 
user’s manual.  To maintain peak performance, factory service and recalibration  
is recommended every two years. 
 
Requesting Factory Service for Your Model 3600i 
If you feel that factory service may be required, call the Michigan Instruments’ 
Service Department at 800-530-9939 Monday through Friday between the hours 
of 9:00 a.m. and 5:00 p.m. EST.  Please have available the model number,  
serial number, and a description of the problem.  Requests for repair parts or 
any service related questions should also be directed to the Service Department. 
 
If your Model 3600i must be returned to Michigan Instruments, please observe 
the following procedures: 

A. Use the original carton and packing material.  It will provide maximum 
protection during shipping.  If you do not have the original shipping 
carton, they may be purchased from Michigan Instruments. 
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NOTE:  DO NOT USE THE 3600I CASE AS A SHIPPING 
CONTAINER.  It is not designed to withstand the rigorous handling 
that may occur during shipping. 

  
B. Include with the unit: 

1. A description of the problem(s). 
2. The name and phone number of a contact person. 
3. A packing slip listing all of the components being returned. 
4.  Ship via United Parcel Service and insure for $6000.00. 

Ship to: Michigan Instruments, Inc. 
  4717 Talon Ct. S.E. 
  Grand Rapids, MI  49512 
  ATTN:  Service Department 

         
C.  Upon receipt, the unit will be evaluated and a repair estimate 
      prepared for approval.  Michigan Instruments will contact you with 
      the estimate and wait for approval and purchase order before 
      repairs are started.  Repairs will be completed within two weeks 
      from the date of approval. 
D. All units returned to Michigan Instruments must be evaluated and 

require a $50.00 evaluation fee plus shipping charges.  This fee will 
be charged if repairs are not authorized and the unit is returned 
unrepaired. 

E. All repairs, parts, and labor are warranted for 90 days.  New parts  
have a one year warranty.  These warranties are subject to the 
limitations and conditions of the original warranty, and apply only to 
those components actually repaired, rebuilt, or replaced. 

F. A limited number of loaner units are available.  Ask for details. 
G. Terms for repair service: 

1. All repairs not covered by warranty are FOB Michigan Instruments, 
Grand Rapids, MI.  Freight charges will be added to the invoice. 

2. Payment is net 30 days. 
3. Open accounts are subject to credit approval. 
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6. Warnings and Cautions 
 
Warning:  Explosion Hazard:  If this equipment is used to measure flammable 
        anesthetics or other gases, provide adequate ventilation and ensure  
        that no leaks are present in the system that would permit the accum- 
        ulation of such gases in the electronics enclosure. 
 
Warning:  Electrical Shock Hazard:  When plugged in, 12 V is present within the 
        enclosure of the 3600i.  Attachment, removal, and servicing of the 
        Electronic Interface Module should be performed only by Michigan      
        Instruments, Inc.  
 
Caution:   Operate the 3600i within its specified limits.  Over-inflation of the  
        bellows or excessive pressure within the system may cause damage 
                  to the bellows, gauge, or transducers. 
 
Caution:   To prevent damage during shipping and handling, set and lock the 
                  compliance spring at the .01 setting. 
 
Caution:   Do not sterilize the 3600i.  The internal components are not compat- 
                  ible with sterilization techniques. 
 
Caution:   The 3600i should be turned off and unplugged while moving the 
                  unit and between uses.    
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7. Storage and Shipping 
 
The Model 3600i Single Lung PneuView System is shipped to the customer in 
a Carrying/Storage case which is packaged in a specially designed shipping 
carton.  The Carrying/Storage case is used to protect the 3600i when not in use, 
and should be used to transport the unit.  However, if the unit needs to be 
shipped via United Parcel Service or other carrier, place the unit in the original 
shipping carton.  Replacement cartons are available at Michigan Instruments. 
(See Factory Service Policy for servicing instructions.) 
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